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CK-RX65N 

Getting Started Guide with RYZ014A Azure Cellular Application 

Introduction 

This document describes a system that uses the CK-RX65N Cloud Kit board from Renesas. This system 
  incorporates the CK-RX65N running Azure RTOS and via an Ethernet/Cellular connection visualizes  
  HS3001, ZMOD4410, ZMOD4510, OB1203, ICP10101 and ICM20948 sensors information on Azure IoT 
  Explorer and controls LEDs on the board. 

There are two ways of connectivity for CK-RX65N. One is the Ethernet, second is the Cellular Cat-M1. 
  This document shows both connectivity. 

And this document shows the way of below items. 

- How to activate the SIM card that is contained the CK-RX65N

- How to operate and install the information of certification for cloud

- How to see and run the sensor data on the Azure IoT viewer

Figure 1.  CK-RX65N(with RYZ014A Pmod) 
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https://github.com/renesas/RX-Azure-PnP-sample/tree/v.1.0.0_CKRX65N_Cellular/ckrx65n_cellular
https://github.com/renesas/RX-Azure-PnP-sample/tree/v.1.0.0_CKRX65N_Cellular/ckrx65n_cellular/prebuilt_binary


CK-RX65N Getting Started Guide with RYZ014A Azure Cellular Application 

R01AN6870EJ0110  Rev.1.10  Page 2 of 52 

Jun.02.23 
 

Contents 

1. Terms ...................................................................................................................................... 3 

2. Preparation .............................................................................................................................. 3 

2.1 Hardware Configuration ..................................................................................................................... 3 

2.2 Software Configuration ....................................................................................................................... 3 

2.3 Tera term Setting ............................................................................................................................... 4 

3. System Diagram ...................................................................................................................... 4 

4. Activating a SIM card ............................................................................................................... 5 

4.1 Activating a SIM card on Truphone ..................................................................................................... 5 

4.2 Activating a SIM card on MicroAI Launchpad...................................................................................... 8 

5. Azure Account and Credentials Creation ............................................................................... 14 

5.1 Install Azure CLI ............................................................................................................................... 14 

5.2 Create an IoT Hub ........................................................................................................................... 15 

5.3 Certificate Creation Process ............................................................................................................. 18 

5.4 View Device Properties .................................................................................................................... 21 

5.5 Set IoT Hub ...................................................................................................................................... 21 

5.6 Register an IoT Hub Device .............................................................................................................. 25 

5.7 Prepare the Device .......................................................................................................................... 26 

6. Common users: To import the project and Run ...................................................................... 27 

6.1 Import the project ............................................................................................................................. 27 

6.2 Serial Terminal Settings ................................................................................................................... 34 

6.3 Storing Device Certificate, Host Name, Device ID ............................................................................. 37 

6.4 Send Device to Cloud Message........................................................................................................ 41 

6.5 Send Cloud-to-Device Message ....................................................................................................... 41 

7. IoT Plug and Play Certification Requirements ........................................................................ 43 

7.1 Program Purpose ............................................................................................................................. 43 

7.2 Requirements .................................................................................................................................. 43 

8. Azure IoT Central architecture ............................................................................................... 48 

8.1 Manage devices ............................................................................................................................... 48 

8.1.1 View and analyze data ................................................................................................................... 49 

8.1.2 Secure your solution ...................................................................................................................... 49 

8.2 Devices ............................................................................................................................................ 49 

8.3 Gateways ......................................................................................................................................... 49 

8.4 Export data ...................................................................................................................................... 50 

9. Note and trouble shooting. ..................................................................................................... 50 

9.1 About stabilization time for sensor .................................................................................................... 50 

9.2 Connection issue when using Ethernet (Wired cable) ....................................................................... 50 



CK-RX65N Getting Started Guide with RYZ014A Azure Cellular Application 

R01AN6870EJ0110  Rev.1.10  Page 3 of 52 

Jun.02.23 
 

9.3 About the trouble of current supply short when using RYZ014A ........................................................ 50 

9.4 About when build errors occur .......................................................................................................... 50 

Revision History ............................................................................................................................ 52 

General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products .. 53 

Notice ........................................................................................................................................... 54 

Corporate Headquarters ............................................................................................................... 54 

Contact information ....................................................................................................................... 54 

Trademarks ................................................................................................................................... 54 

 

1. Terms 

Terms  
Terms used in this document are explained below.  
Table 1.1 Terms  

Term  Meaning  

IoT  Internet of Things 

 

2. Preparation 

2.1 Hardware Configuration 

The hardware configuration of the demo project is listed in the table below.  

Item Content Description 

CK-RX65N Cloud Kit  Target board for  
CK-RX65N  

Please see detail. 

https://www.renesas.com/rx/ck-
rx65n 

RYZ014A Cellular PMOD 
module  

SIM card This PMOD is contained with CK-
RX65N of kit with SIM card 

PC  Windows 10  

Azure IoT Explorer (0.14.5.0) 
Recommended OS  

Azure cloud Data viewer 
 

 

2.2 Software Configuration 

The software configuration of the demo project is listed in the table below.  

Item Content Version 

Integrated development 
environment  

e2 studio  2023-01 or Later 

Complier CC-RX 

GCC(Planning) 

V3.04 

- 

https://www.renesas.com/rx/ck-rx65n
https://www.renesas.com/rx/ck-rx65n
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Communication Software Tera term Version 4.106 

Emulator  E2 emulator Lite (on-board)  - 

OpenSSL  3.0.5 

RTOS Azure RTOS V6.1.11 

 

2.3 Tera term Setting 

Item Settings 

Baud rate 115200 

Data length 8 

Parity none 

Stop bits 1 

Flow Control none 

3. System Diagram 

 

Figure 2.  System Diagram 

Azure Dashboard OB1203 Sensor 
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4. Activating a SIM card 

One of two SIM cards is included in this kit that is Truphone or MicroAI Launchpad.  

Please activate the SIM card as following steps depending on the included SIM card. 

 

4.1 Activating a SIM card on Truphone 

To activate the included Truphone SIM card, please visit the Truphone SIM Activation platform at 
truphone.com/connectit and use the following steps: 

1. On the Business page, click Start activation button under IoT SIM Activation. 

 

Figure 3.   Activating the SIM Card on Truphone 

2. Create a new Truphone Account by selecting Sign up (next to Don’t have an account yet?) and fill-in 
your full name, Email, and a password. Then click Sign up to create a new account. 

 

Figure 4.   Signing in 

 
 

3. Select Personal as the account type and press Get Started. 

https://truphone.com/connectit
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Figure 5.   Selecting the account type 

 

4. Verify your email by entering the activation code sent to your email account. 

 

Figure 6.   Verifying the email 

 
5. Complete the Profile information form – then select Create account.  
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Figure 7.   Completing the Profile information 

 
6. Select Activate SIMS to activate your individual SIM by ICCID. 

 

Figure 8.   Activating SIM 

 
7. Enter the ICCID value. 

 

Figure 9.   Entering the ICCID 

 
8. You will receive email confirmation when the SIM card activation is complete. 

The CK-RX65N kit and SIM card should be activated and can be validated on the Tera Term terminal. 

 
Note: The SIM card includes free credit for the first 90 days/50MB. 
After expiring the free data charge, Communication charges will be incurred. 

 

Disclaimer 
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The activation steps above are provided by SIM Provider Truphone. They are the most current at the time of 

publishing this application note. If you need help activating your SIM card, contact Truphone support 

iot.truphone.com or Contact Support | Truphone. 

If you have a SIM card from any other provider then contact the technical support for that provider.  

For any other issue that cannot be resolved please contact Renesas Support at Technical Support. 

 

Note:  The SIM card provider for the Quick Start Guide example project is Truphone. If you use any other 

SIM card provider you must change the Access Point Name required for the SIM card provider in your 

global region. Failure to do so could result in the RYZ014A not connecting to the cellular network. 

 
 

4.2 Activating a SIM card on MicroAI Launchpad 

The MicroAI Launchpad platform will be needed for the activation of the SIM card. To activate the SIM 
card, use the following steps: 

1. Create a Launchpad account. Do so by registering on the sign-up page and verifying the account 
through the verification email sent after registration. 
 

2. Login to the new Launchpad account and click on the Create Device Profile tile. Make sure Renesas 
CK-RX65N(or Renesas RSK-RX65N when missing CK-RX65N) is selected for the Device Type and 
CAT-M for the Connectivity Type. Fill other fields as desired then click Next. 
 

 
Figure 10.  Create Device Profile on MicroAI Launchpad 

 

 

https://iot.truphone.com/
https://www.truphone.com/support/contact-support/
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/rx-32-bit-performance-efficiency-mcus/support
https://renesas.micro.ai/auth/login
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Figure 11.   Input the information of Profile 

 

3. On Data Schema, click Next. 

 Renesas CK-RX65N 
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Figure 12.   Data schema 

 

4. On Select a Plan, apply any valid promo codes if applicable and click Next. 
 
 

Note: 
The SIM card contained in Kit credit for first 1 month/50MB fee. You can see 

credited information in invoice center on your account. 
After expiring the free data charge, Communication charges will be incurred. 
If you need that it doesn’t need to use this SIM card with payment, please set the device status to 

"suspended" to stop the communication charge.  
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Figure 13.   See the plan of SIM and trial time 

 
5. Provide a Payment Method and accept the terms and conditions. Click Finish. 

 
Figure 14.  Input he payment method 

 
 

6. Click the Register a Device tile to begin registering the CK-RX65N kit and SIM card. Select the device 
profile created from the device profile drop-down.  
 

7. Select your Device Profile you created previous step. 
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8. Enter the IMEI value obtained from the CLI of section “4.14 Running the application & activation of SIM 
card contain with CK-RX65N”  into the “Device ID”. Fill other fields as needed. 

 

Note: Please be careful, the “Device ID” cannot change after registration of this step. 
 

 
Figure 15.  Registering a device of CK-RX65N on MicroAI Launchpad 

 

 
Figure 16.  Enter Device ID 

https://www.renesas.com/document/qsg/ck-rx65n-sim-activation-creating-trial-account-and-using-dashboard-getting-started-guide-ck-rx65n?language=en&r=1611756#page19
https://www.renesas.com/document/qsg/ck-rx65n-sim-activation-creating-trial-account-and-using-dashboard-getting-started-guide-ck-rx65n?language=en&r=1611756#page19
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9. Click Next and click Add New SIM. Enter the ICCID value for the SIM EID field and click Save SIM. 

 
Figure 17.  Add new SIM 

 
Figure 18.  Activating the SIM card on MicroAI Launchpad 

 

Finish the device registration. The CK-RX65N kit and SIM card should be activated on the Launchpad 
platform and can be validated on the Tera Term terminal. 
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5. Azure Account and Credentials Creation 

5.1 Install Azure CLI 

To prepare Azure cloud resources and connect a device to Azure, you can use Azure CLI. Azure 

CLI can be installed locally on your PC. 

1. Azure CLI can be downloaded from the Microsoft site (https://docs.microsoft.com/en-

us/cli/azure/install- azure-cli) 

2. Note: The installer name will be similar to azure-cli-2.44.x.msi. or later. Click on the installer 

and the install shield will guide you through the installation process. 

3. Install the current release of the Azure CLI. After the installation is complete, you will need to 

close and reopen any active Windows Command Prompt or PowerShell windows to use the 

Azure CLI. 

4. After the Azure CLI installation is successful, open and launch the Windows PowerShell to use 

the Azure CLI. A screenshot of the Windows PowerShell is shown below. 

 
 

Figure 19.  Windows Power Shell 

 

5. If you already have Azure CLI installed locally, run az - -version to check the version. This app 

note requires Azure CLI 2.44.0 or later. 

 

Figure 20.  AZURE CLI Version 

https://docs.microsoft.com/en-us/cli/azure/install-azure-cli
https://docs.microsoft.com/en-us/cli/azure/install-azure-cli
https://docs.microsoft.com/en-us/cli/azure/install-azure-cli
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5.2 Create an IoT Hub 

You can use Azure CLI to create an IoT hub that handles events and messaging for your device. 

Note 1: Before you start creating the IoT Hub you are required to have a login to your Azure Portal 

via web browser. If not, then you may notice an error that you are not logged in while creating the IoT 

hub, you may notice an error that you are not logged in. 

https://portal.azure.com/ 

Note 2: If you do not have the Azure Account, you can create one which is valid for 12 months 

with limited features from the following link 

https://azure.microsoft.com/en-us/free/ 

To create an IoT hub: 

Note 3: Some of the user parameters while creating the IoT Hub needs to be unique. Users are 

required to take care of this while creating the IoT Hub credentials. 

1. In your CLI console, run the az extension add command to add the Microsoft Azure IoT 

Extension for Azure CLI to your CLI shell. The IoT Extension adds IoT Hub, IoT Edge, and IoT 

Device Provisioning Service (DPS) specific commands to Azure CLI. 

⎯ az extension add --name azure-iot 

Note 4: When you run the command for the first time you may not notice output on the console as shown 
below. It just accepts the command. 
 

 

Figure 21.  Add Extension for Azure CLI 

 

2. Run the az login command to login to the Azure account. Running the az login command 

opens the browser for login. You can enter the login credentials to login to the Azure account. 
You will notice a similar message on the browser on successful login. 

 

Note: You can find more info on the Azure CLI at Overview of the Azure CLI | Microsoft Docs 
 

 

Figure 22.  Successful Login to the Azure account 

https://portal.azure.com/
https://azure.microsoft.com/en-us/free/
https://docs.microsoft.com/en-us/cli/azure/
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3. Run the az group create command to create a resource group. The following command 

creates a resource group named MyRXResourceGroup in the westus region. 

4. Note: Optionally, to set an alternate location, run az account list-locations to see 

available locations. Then specify the alternate location in the following command in place of 
westus. 

⎯ az group create --name MyRXResourceGroup --location westus 

 

 

Figure 23.  Create Resource Group 

5. Run the az iot hub create command to create an IoT hub. It might take a few minutes to 

create an IoT hub. 

Replace the YourIotHubName placeholder below with the name you chose for your IoT hub. 

An IoT hub name must be globally unique in Azure. This placeholder is used in the rest of 
this tutorial to represent your unique IoT hub name. Use any command given below. 

⎯ az iot hub create --resource-group MyRXResourceGroup --name 

{YourIoTHubName} 

OR 

⎯ az iot hub create --resource-group MyRXResourceGroup --name 

{YourIoTHubName}  --location {YourLocation} 

 

Note: It may take few minutes to create the IoT Hub. In this case the IoTHub name used is 

RXCLOUDHUB. 

Note: Microsoft recommends to create new IoT Hub. If the IoT hub created previously (2-3 year 
old ) it may not work as desired. So we recommend to create new IoT Hub to run the application 
to yield the proper results 

 

Figure 24.  IoT Hub Creation in Progress 

MyRXResourceGroup 

MyRXResourceGroup”, 

“MyRXResourceGroup”, 

MyRXResourceGroup RXCLOUDHUB 
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6. After the IoT hub is created, view the JSON output in the console, and copy the hostName 

value to a safe place. You use this value in a later step. The hostName value looks like the 

following example: 

⎯ {Your IoT hub name}.azure-devices.net 

 

Figure 25.  JSON Output after IoT Hub Creation 

MyRXResourceGroup RXCLOUDHUB 

“RXCLOUDHUB.azure-devices.net”,     

“RXCLOUDHUB”, 

RXCLOUDHUB”, 

“rxcloudhub”, 
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5.3 Certificate Creation Process  

 

You can use GIT BASH utility for this process. All OpenSSL commands and Self Signed Certificate 

creation process is given on this link.  

 

Steps as below 

1. Set x509 configuration file for common name in cert.      

 

Figure 26. Set X509 Configuration File 

 

2. Create RSA self-signed certificate 

 
Generate private key and certificate (public key) using the command as shown in the snapshot  

“openssl genrsa -out privkey.pem 2048” 

 

Figure 27. Generate private key and certificate 
(public key) 

 

https://github.com/azure-rtos/netxduo/blob/master/addons/azure_iot/samples/README.md#steps-to-create-self-signed-certs-using-openssl
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3. Embed Device ID in certificate  

This command will not give you any response if successfully executed. 

openssl req -new -days 365 -nodes -x509 -key privkey.pem -out cert.pem -config x509_config.cfg -subj 
"//CN=<Same as device Id>" 

 

Figure 28. Embed Device ID in certificate 

 

4. Convert format of key from pem to der “openssl rsa -outform der -in privkey.pem -out privkey.der" 
Here you get response “writing RSA key” 

 

Figure 29. Convert format from key to der 

 

5. Convert format of cert from pem to der   “openssl x509 -outform der -in cert.pem -out cert.der” 

This command will not give you any response if successfully executed.  

 

Figure 30. Convert format of cert from pem to der 

 

6. Convert der to hex array (ubuntu) and set them in sample_device_identity.c 

 

CK_RX65N_X509” 
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7. Check whether sample_device_identity.c is created. 

 

Figure 31. Convert der to hex array and set them in Sample_device_identity.c 

 

8. Producing sample_device_cert_ptr and sample_device_private_key_ptr array containing 

device certificate and private key equivalent hex values along with length. 

 

“xxd -i cert.der | sed -E "s/(unsigned char) (¥w+)/¥1 sample_device_cert_ptr/g; s/(unsigned int) 
(¥w+)_len/¥1 sample_device_cert_len/g" >> sample_device_identity.c” 

 

“xxd -i privkey.der | sed -E "s/(unsigned char) (¥w+)/¥1 sample_device_private_key_ptr/g; s/(unsigned int) 
(¥w+)_len/¥1 sample_device_private_key_len/g" >> sample_device_identity.c” 

 

These commands will not give you any response if successfully executed. 

 

Figure 32. Producing arrays containing hex values 

 

Check the content of   sample_device_identity.c with cat command.  In this file you will get Device 
certificate along with SHA1 fingerprint,Device Private Key, sample_device_cert_ptr and 

sample_device_private_key_ptr array along with their length.This fingerprint you have to use in device 

creation process.  
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Figure 33. Check the content of sample_device_identity.c 

 

5.4 View Device Properties 

You can use the Azure IoT Explorer (https://docs.microsoft.com/en-us/azure/iot-pnp/howto-use-iot-

explorer) to view and manage the properties of your devices. In the following steps, you'll add a 

connection to your IoT hub in IoT Explorer. With the connection, you can view properties for devices 

associated with the IoT hub. 

Download and install latest (above v0.15.6.0) Azure IoT Explorer from: 

https://github.com/Azure/azure-iot- explorer/releases 

Note: Click and install the downloaded msi file Azure.IoT.Explorer.Preview.0.15.6.msi or 

newer version of the downloaded file. The install shield guides you through the installation 
process. 

 

5.5  Set IoT Hub 

To add a connection to your IoT hub: 

1. In your Azure  CLI console, run the az iot hub show-connection-string command to get 

the connection string for your IoT hub.  

⎯ “az iot hub connection-string show -n {YourIoTHubName}” 

 

Figure 34. Connection String 

 

 

RXCLOUDHUB 

RXCLOUDHUB 

https://docs.microsoft.com/en-us/azure/iot-pnp/howto-use-iot-explorer
https://docs.microsoft.com/en-us/azure/iot-pnp/howto-use-iot-explorer
https://github.com/Azure/azure-iot-explorer/releases
https://github.com/Azure/azure-iot-explorer/releases
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2. Copy the connection string. 

3. Open the Azure IoT Explorer and select IoT hubs > Add connection. 

4. Paste the connection string into the Connection string box. 

5. Select Save. 

 

 
 

Figure 35. Adding Connection String 

Note: In some cases, Azure IoT Explorer may report an error that the default port that IoT Explorer 

is trying to use is being used by another application. In order to overcome this error, you can 

add a different port number for the Azure IoT Explorer as shown below. 

Go to your PC, edit the system environmental variables similarly to the screenshots shown below. 

 

 

 

 RXCLOUDHUB   

RXCLOUDHUB   
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Figure 36. Editing System Environment Variable 

 

 

Figure 37. Adding System Environment Variable for Alternate Port - Azure IoT Explorer 
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Figure 38. Added Alternate Port for Azure IoT Explorer 

If the connection succeeds, the Azure IoT Explorer switches to a Devices view and lists your device. 

 

Figure 39. Listed Devices 
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5.6 Register an IoT Hub Device 

In this section, you create a new device instance and register it with the IoT Hub you created. You 

will use the connection information for the newly registered device to securely connect your physical 

device in a later section. 

To register a device: 

1. You can Create Device with help of Azure IoT Explorer as below  

Click on New. 

 

Figure 40. New Device Creation process with Azure IOT Explorer 
 

2. In this stage, you have to give Device ID, Authentication type, Primary thumbprint, Secondary 

thumbprint then click on Create. Use fingerprint generated in previous section (Figure 31) for the 

primary and secondary thumbprints.  

 

Figure 41. Naming, Authentication type and Thumbprints 
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3. You can see your created device in Devices section of AZURE IoT Explorer 

 

Figure 42. Newly Created Device 

 

5.7 Prepare the Device 

To connect the device to Azure, modify a configuration file for Azure IoT settings(of your Device ID 

and Hostname), build and flash the image to the device. 

Add configuration 

1. Import the application project into an empty e2 studio. Open sample_config.h and make the 
changes to the configuration as shown in the snapshot with your Hostname, deviceId  and 
USE_DEVICE_CERTIFICATE. 
 

Constant name Value 

HOST_NAME {Your IoT hub hostName value} 

DEVICE_ID {Your deviceID value} 

USE_DEVICE_CERTIFICATE 1 
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6. Common users: To import the project and Run 

6.1 Import the project 

 

Follow the steps below to prepare the software for the demo program.  
1. Extract the project files from the archive and copy them to the C drive.  

Please unzip it the project file to the short path of your PC. 
  If the path is deep, it happened the build error due to the file path length issue. 

 
2. Launch e2 studio and specify a workspace directory and click Launch 

 

Figure 43. Launch e2 studio 

 
3. Select File → Import…. 

 

Figure 44. select import 
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4. Click General → Existing Projects into Workspace → Next >. 

 

Figure 45. select Existing Projects into Workspace 

 

5. Click Browse…, then specify the root directory as follows.  

 

Figure 46. find the project 
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And you can choose two types of connectivity and compiler when import the project. 
Please go to “ [Project Root folder]\projects\renesas\” folder 
 
Detail of each project 

Project Name Compiler Connectivity 

rx65n-new-ck in the “ck_rx65n_azure_iot_pnp” zip 
CC-RX 

Ether 

rx65n-new-ck-cellular in the “ewf_fork” zip Cellular 

rx65n-new-ck-gcc (Planning) 
GCC 

Ether 

rx65n-new-ck-cellular-gcc (Planning) Cellular 

 

 

Figure 47. Project files 

 

This case, it explains when selecting “ckrx65n_pnp_ryz014a_ccrx” of cellular project. 
Open the “ C:\ewf_fork\examples\CK_RX65N_CCRX\ckrx65n_pnp_ryz014a_ccrx” folder 

If you use other one, please open “¥ckrx65n_pnp_ryz014a_ccrx” folder of your selecting project. 
 

 

Figure 48. select the project folder 
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6. Finally, click Finish. (Note: Make sure Copy projects into workspace is unchecked. ) 

 

Figure 49. Finish the import the project 
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7. Check and set the SIM card information 
 
Doble click the “ckrx65n_pnp_ryz014a_ccrx.sfg” to open the smart configurator. 

 

Figure 50. Open the Smart Configurator 
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8. Execute code generation 

If you have changed the Smart Configurator settings, click Generate Code. 

 

Figure 51. Generate Code 

 
9. Select Project → Build project and confirm that 0 errors are reported.  
 
Note: Make sure to clean the project before building it for the first time. If a demo build error occurs after 

the initial build, clean the project again and then build it.  

 

Figure 52. Build the project 
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10. Debug Configuration  

 

Figure 53. Configuration debugger 1/2 

  

  

Figure 54. Configuration debugger 2/2 
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Figure 55. Start Debug 

 

 

 

Figure 56. Run 

 

6.2 Serial Terminal Settings 

1. Open Device manager 

 

Figure 57.   USB Serial Device in Windows Device Manager 
 

2. Open Tera Term select New connection and select Serial and COMxx: USB Serial Device 

(COMxx) and click OK. 

 

Figure 58.   Selecting the Serial Port on Tera Term 
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3. Using the Setup menu pull-down, select Serial port… and ensure that the speed is set to 
115200. 

s 

Figure 59.   Select 115200 on the Speed Pulldown 

 

 
Figure 60.   Tera term settings 

 

 
Figure 61.   Tera term settings 
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4. Complete the connection. The Configuration CLI Menu will be displayed on the console as shown 
below. 
 
Note: Please reset the board by pressing the S1 user switch if the menu is not displayed. 

 

Figure 62.   Main Menu 

5. Here you can select options from the MENU by pressing key 1 to 5. Press spacebar to go to 

previous menu FSP Version and UUID details as below. 

 

Figure 63. Version Information 

 

 

Figure 64.   Getting Board UUID Information 
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6.3 Storing Device Certificate, Host Name, Device ID  

Please reset the board by pressing the S1 user switch if the menu is not displayed. 

 

Figure 65.   Main Menu 

1. Press 2 on the Main Menu to display Data Flash related commands as shown in the following 
screenshots. This sub menu has commands to store, read, and validate the data. 

 

Figure 66.   DATA Flash Menu 

 

2. Press 2 on the Main Menu to display Data Flash related commands as shown in the following 
screenshots. This sub menu has commands to store, read, and validate the data. 

 

3. Press b for Write Certificate. 

 

Figure 67.   Select file to write data in data flash. 
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4. Go to Tera Term->File->Send file 

 

Figure 68.   Send file option in File Menu 

 

5. Browse to the folder where X509 certificates are generated.  

Select cert.pem. Press Open. 

 

Figure 69.   Browse, Select and Open the file to be written 
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6. Status of Device Certificate Downloading as below 

 

Figure 70.   Status of file writing process. 

 

7. Similarly to store device private key press c in Data Flash menu, Go to Tera Term->File-

>Send file Select file privkey.pem from the folder where you have generated Certificates. 
 

8. To store MQTT Broker End point aka Host Name, first copy Host Name without double 
quotes then press d in Data Flash menu, Go To Tera Term ->Edit->Paste<CR>, you will get 

copied Host Name in Clipboard, please verify and confirm it and press OK 

 

Figure 71.      Input MQTT Broker End point aka Host Name 

 

9. To store IOT Thing Name aka DEVICE ID, first copy DEVICE ID created without double 

quotes,press e in Data Flash Menu and follow the procedure in step 5. 

 

Figure 72.      Input Device ID aka IOT Thing name 

10.  To verify the data stored in  DATA flash press f in Data Flash menu, scroll down to see 
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data. 

 

Figure 73. Scroll down and verify the data stored in DATA flash 

 

11.  Sensor Data Output on Serial Terminal 

 

Figure 74. Sensor Data on Serial Terminal 
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6.4 Send Device to Cloud Message 

With Azure IoT Explorer, you can view the flow of telemetry from your device to the cloud. 

To view telemetry in Azure IoT Explorer: 

1. In IoT Explorer select Telemetry. Confirm that use built-in event hub is set to Yes. 

2. Select Start. 

3. View the telemetry as the device sends messages to the cloud. 

 

Figure 75. Device Telemetry Details 

 

6.5 Send Cloud-to-Device Message 

To send a cloud-to-device message in Azure IoT Explorer: 

1. In IoT Explorer select Cloud-to-device message. 
2. Enter the message in the Message body = "LED", Key = LED, Value = Given in Table 
3. Check Add timestamp to message body. 
4. Select Send message to device. 

 

LED On Board Value 

LED2 (Tri Color LED) TC_GREEN_ON, TC_RED_ON, TC_BLUE_ON 

TC_GREEN_OFF, TC_RED_OFF, TC_BLUE_OFF 

LED4 BLUE BLUE_ON, BLUE_OFF 
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Figure 76.  Device Telemetry Details 

 

In the terminal window, you can see that the message is received by the IoT Device. 

 

Figure 77.  Serial Terminal Output 

1 

2 

3 4 

6 

 5 1 
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7. IoT Plug and Play Certification Requirements 

 

This section outlines the device specific capabilities that will be represented in the Azure IoT Device catalog. 
A capability is singular device attribute that may be software implementation or combination of software and 
hardware implementations. 

 

7.1 Program Purpose 

IoT Plug and Play enables solution builders to integrate smart devices with their solutions without any 
manual configuration. At the core of IoT Plug and Play, is a device model that advertises the device 
capabilities to an IoT Plug and Play-enabled application. 

Promise of IoT Plug and Play certification are: 

1. Defined device models and interfaces are compliant with the Digital Twin Definition Language 
2. Easy integration with Azure IoT based solutions using the Digital Twin APIs : Azure IoT Hub 

and Azure IoT Central 
3. Product truth validated through testing telemetry from end point to cloud using DTDL 

 Note 
Upon completed testing and validation, we may request that the product is evaluated by Microsoft. 

 

7.2 Requirements 

[Required] Device to cloud: The purpose of test is to make sure devices that send telemetry works 
with IoT Hub 

Name IoTPnP.D2C 

Target 
Availability 

Available now 

Applies To Leaf device/Edge device 

OS Agnostic 

Validation 
Type 

Automated 

Validation Device must send any telemetry schemas to IoT Hub. Microsoft provides the portal workflow to 
execute the tests. Device to cloud (required): 1. Validates that the device can send message to 
AICS managed IoT Hub 2. User must specify the number and frequency of messages. 3. AICS 
validates the telemetry is received by the Hub instance 

Resources Certification steps (has all the additional resources) 

 

https://github.com/Azure/opendigitaltwins-dtdl
https://learn.microsoft.com/en-us/azure/iot-develop/concepts-digital-twin
https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/certification/overview
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[Required] DPS: The purpose of test is to check the device implements and supports IoT Hub Device 
Provisioning Service with one of the three attestation methods 

Name AzureCertified.DPS 

Target 
Availability 

New 

Applies To Any device 

OS Agnostic 

Validation 
Type 

Automated 

Validation Device supports easy input of target DPS ID scope ownership. Microsoft provides the portal 
workflow to execute the tests to validate that the device supports DPS 1. User must select one 
of the attestation methods (X.509, TPM and SAS key) 2. Depending on the attestation method, 
user needs to take corresponding action such as a) Upload X.509 cert to AICS managed DPS 
scope b) Implement SAS key or endorsement key into the device 

Resources Device provisioning service overview  

 

[Required] DTDL v2: The purpose of test to ensure defined device models and interfaces are 
compliant with the Digital Twins Definition Language v2. 

Name IoTPnP.DTDL 

Target 
Availability 

Available now 

Applies To Any device 

OS Agnostic 

Validation 
Type 

Automated 

Validation The portal workflow validates: 1. Model ID announcement and ensure the device is connected 
using either the MQTT or MQTT over WebSockets protocol 2. Models are compliant with the DTDL 
v2 3. Telemetry, properties, and commands are properly implemented and interact between IoT 
Hub Digital Twin and Device Twin on the device 

Resources Public Preview Refresh updates 

 

https://certify.azure.com/
https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/iot-dps/about-iot-dps
https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/iot-develop/overview-iot-plug-and-play
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[Required] Device models are published in public model repository 

Name IoTPnP.ModelRepo 

Target 
Availability 

Available now 

Applies To Any device 

OS Agnostic 

Validation 
Type 

Automated 

Validation All device models are required to be published in public repository. Device models are resolved 
via models available in public repository 1. User must manually publish the models to the public 
repository before submitting for the certification. 2. Note that once the models are published, it is 
immutable. We strongly recommend publishing only when the models and embedded device 
code are finalized.*1 *1 User must contact Microsoft support to revoke the models once published 
to the model repository 3. Portal workflow checks the existence of the models in the public 
repository when the device is connected to the certification service 

Resources Model repository 

 

[If implemented] Device info Interface: The purpose of test is to validate device info interface is 
implemented properly in the device code 

Name IoTPnP.DeviceInfoInterface 

Target 
Availability 

Available now 

Applies To Any device 

OS Agnostic 

Validation 
Type 

Automated 

Validation Portal workflow validates the device code implements device info interface 1. Checks the 
values are emitted by the device code to IoT Hub 2. Checks the interface is implemented in 
the DCM (this implementation will change in DTDL v2) 3. Checks properties are not write-able 
(read only) 4. Checks the schema type is string and/or long and not null 

Resources Microsoft defined interface 

Azure 
Recommended 

N/A 

 

 

 

 

https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/iot-develop/overview-iot-plug-and-play
https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/iot-develop/overview-iot-plug-and-play
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[If implemented] Cloud to device: The purpose of test is to make sure messages can be sent from 
cloud to devices 

Name IoTPnP.C2D 

Target 
Availability 

Available now 

Applies To Leaf device/Edge device 

OS Agnostic 

Validation 
Type 

Automated 

Validation Device must be able to Cloud to Device messages from IoT Hub. Microsoft provides the portal 
workflow to execute these tests. Cloud to device (if implemented): 1. Validates that the device 
can receive message from IoT Hub 2. AICS sends random message and validates via message 
ACK from the device 

Resources 1. Certification steps (has all the additional resources),  
2. Send cloud to device messages from an IoT Hub 

 

 

[If implemented] Direct methods: The purpose of test is to make sure devices works with IoT Hub and 
supports direct methods 

Name IoTPnP.DirectMethods 

Target 
Availability 

Available now 

Applies To Leaf device/Edge device 

OS Agnostic 

Validation 
Type 

Automated 

Validation Device must be able to receive and reply commands requests from IoT Hub. Microsoft provides 
the portal workflow to execute the tests. Direct methods (if implemented): 1. User has to specify the 
method payload of direct method. 2. AICS validates the specified payload request is sent from Hub 
and ACK message received by the device 

Resources 1. Certification steps (has all the additional resources),  
2. Understand direct methods from IoT Hub 

 

 

 

 

https://certify.azure.com/
https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/certification/overview
https://learn.microsoft.com/en-us/azure/iot-hub/iot-hub-devguide-messages-c2d
https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/certification/overview
https://learn.microsoft.com/en-us/azure/iot-hub/iot-hub-devguide-direct-methods


CK-RX65N Getting Started Guide with RYZ014A Azure Cellular Application 

R01AN6870EJ0110  Rev.1.10  Page 47 of 52 

Jun.02.23 
 

[If implemented] Device twin property: The purpose of test is to make sure devices that send 
telemetry works with IoT Hub and supports some of the IoT Hub capabilities such as direct methods, 
and device twin property 

Name IoTPnP.DeviceTwin 

Target 
Availability 

Available now 

Applies To Leaf device/Edge device 

OS Agnostic 

Validation 
Type 

Automated 

Validation Device must send any telemetry schemas to IoT Hub. Microsoft provides the portal workflow to 
execute the tests. Device twin property (if implemented): 1. AICS validates the read/write-able 
property in device twin JSON 2. User has to specify the JSON payload to be changed 3. AICS 
validates the specified desired properties sent from IoT Hub and ACK message received by the 
device 

Resources 1. Certification steps (has all the additional resources),  
2. Use device twins with IoT Hub 

 

https://certify.azure.com/
https://learn.microsoft.com/en-us/azure/certification/overview
https://learn.microsoft.com/en-us/azure/iot-hub/iot-hub-devguide-device-twins
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8. Azure IoT Central architecture 

1. Devices 

2. Gateways 

3. Export data 

 

IoT Central is a ready-made environment that lets you quickly evaluate your IoT scenario. It's an 
application platform as a service (aPaaS) IoT solution and its primary interface is a web UI. There's also 
a REST API that lets you interact with your application programmatically. 

This article provides an overview of the key elements in an IoT Central solution architecture. 

 

Figure 78.  IoT Central Architecture 

 

Key capabilities in an IoT Central application include: 

 

8.1 Manage devices 

IoT Central lets you manage the fleet of IoT devices that are sending data to your solution. For example, you 
can: 

• Control which devices can connect to your application and how they authenticate. 

• Use device templates to define the types of device that can connect to your application. 

• Manage devices by setting properties or calling commands on connected devices. For 
example, set a target temperature property for a thermostat device or call a command to 
trigger a device to update its firmware. You can set properties and call commands on: 

o Individual devices through a customizable web UI. 
o Multiple devices with scheduled or on-demand jobs. 

• Maintain device metadata such as customer address or last service date. 

https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-architecture#devices
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-architecture#gateways
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-architecture#export-data
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-architecture#extend-with-rest-api
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-architecture#devices
https://learn.microsoft.com/en-us/azure/iot-central/core/overview-iot-central-developer#how-devices-connect
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-device-templates
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-device-templates#views
https://learn.microsoft.com/en-us/azure/iot-central/core/howto-manage-devices-in-bulk
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-device-templates#cloud-properties
https://learn.microsoft.com/en-us/azure/iot-central/core/media/concepts-architecture/architecture.png#lightbox
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8.1.1 View and analyze data 

In an IoT Central application, you can view and analyze data for individual devices or for aggregated data 
from multiple devices: 

• Use mapping to transform complex device telemetry into structured data inside IoT Central. 

• Use device templates to define custom views for individual devices of specific types. For 
example, you can plot temperature over time for an individual thermostat or show the live 
location of a delivery truck. 

• Use the built-in analytics to view aggregate data for multiple devices. For example, you can 
see the total occupancy across multiple retail stores or identifying the stores with the highest 
or lowest occupancy rates. 

• Create custom dashboards to help you manage your devices. For example, you can add 
maps, tiles, and charts to show device telemetry. 
 

8.1.2 Secure your solution 

In IoT Central, you can configure and manage security in the following areas: 

• User access to your application. 

• Device access to your application. 

• Programmatic access to your application. 

• Authentication to other services from your application. 

• Audit logs track activity in your application. 
To learn more, see the IoT Central security guide. 

 

8.2 Devices 

Devices collect data from sensors to send as a stream of telemetry to an IoT Central application. For 
example, a refrigeration unit sends a stream of temperature values or a delivery truck streams its location. 

A device can use properties to report its state, such as whether a valve is open or closed. An IoT Central 
application can also use properties to set device state, for example setting a target temperature for a 
thermostat. 

IoT Central can also control devices by calling commands on the device. For example, instructing a device to 
download and install a firmware update. 

The telemetry, properties, and commands that a device implements are collectively known as the device 
capabilities. You define these capabilities in a model that's shared between the device and the IoT Central 
application. In IoT Central, this model is part of the device template that defines a specific type of device. To 
learn more, see Assign a device to a device template. 

The device implementation should follow the IoT Plug and Play conventions to ensure that it can 
communicate with IoT Central. For more information, see the various language SDKs and samples. 

Devices connect to IoT Central using one the supported protocols: MQTT, AMQP, or HTTP. 

 

8.3 Gateways 

Local gateway devices are useful in several scenarios, such as: 

• Devices can't connect directly to IoT Central because they can't connect to the internet. For 
example, you may have a collection of Bluetooth enabled occupancy sensors that need to 
connect through a gateway device. 

• The quantity of data generated by your devices is high. To reduce costs, combine or 
aggregate the data in a local gateway before you send it to your IoT Central application. 

• Your solution requires fast responses to anomalies in the data. You can run rules on a 
gateway device that identify anomalies and take an action locally without the need to send 
data to your IoT Central application. 

https://learn.microsoft.com/en-us/azure/iot-central/core/howto-map-data
https://learn.microsoft.com/en-us/azure/iot-central/core/howto-set-up-template#views
https://learn.microsoft.com/en-us/azure/iot-central/core/tutorial-use-device-groups
https://learn.microsoft.com/en-us/azure/iot-central/core/howto-manage-dashboards
https://learn.microsoft.com/en-us/azure/iot-central/core/overview-iot-central-security
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-telemetry-properties-commands
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-device-templates#assign-a-device-to-a-device-template
https://learn.microsoft.com/en-us/azure/iot-central/core/tutorial-connect-device
https://learn.microsoft.com/en-us/azure/iot-develop/concepts-convention
https://learn.microsoft.com/en-us/azure/iot-develop/about-iot-sdks
https://learn.microsoft.com/en-us/azure/iot-hub/iot-hub-devguide-protocols
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Gateway devices typically require more processing power than a standalone device. One option to 
implement a gateway device is to use Azure IoT Edge and apply one of the standard IoT Edge gateway 
patterns. You can also run your own custom gateway code on a suitable device. 

 

8.4 Export data 

Although IoT Central has built-in analytics features, you can export data to other services and applications. 

Transformations in an IoT Central data export definition let you manipulate the format and structure of the 
device data before it's exported to a destination. 

 

9. Note and trouble shooting. 

9.1 About stabilization time for sensor 

 

There is stabilization time for each sensor. It cannot read correct values during the time. 

See below the detail of stabilization time of each sensor of table. 

Sensor Name When power up first time After soft or hard reset 

ZMOD4410 IAQ Up to 1 Min Up to 1 Min 

ZMOD4510 OAQ Up to 1.5 hours Up to 1 Hours 

OB1203 Up to 20 Min  

(After putting figure on sensor, 
it may take up to 60 seconds to 
sense data) 

Up to 20 Sec  

(After putting figure on sensor, 
it may take up to 60 seconds to 
sense data) 

HS3001 Up to 30 Sec Up to 10 seconds 

ICP Up to 30 Sec Up to 10 seconds 

ICM Up to 30 Sec Up to 10 seconds 

 

 

9.2 Connection issue when using Ethernet (Wired cable) 

The Ether PYH only supports the full duplex communication. If your rooter or Ethernet hub only supports 
half duplex, it cannot connect the internet. Please use full duplex devices. 

 

9.3 About the trouble of current supply short when using RYZ014A 

If the CK-RX65N board is not powered through the Debug port (J14) the current available to the board may 
be limited to 100 mA. When using the supplied RYZ014A Pmod module with other code (found here: 
RYZ014A - LTE Cat-M1 Cellular IoT Module | Renesas) be aware that this Pmod has a maximum operating 
current of 480 mA dependent upon the LTE band, Tx/Rx settings, and network coverage. Please ensure that 
the host board can supply sufficient power or provide supplemental USB power via CN4 on the Pmod to 
avoid RF instability. 

 

9.4 About when build errors occur 

If a 'No such file or directory' error occurs, the project path may be too long. When the path is longer than 

256 characters, e² studio outputs errors at build time. 

When this error occurs, move the project to a shorter path location (e.g., under C:¥). 

https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-iot-edge
https://learn.microsoft.com/en-us/azure/iot-central/core/concepts-iot-edge
https://learn.microsoft.com/en-us/azure/iot-central/core/howto-transform-data-internally
https://www.renesas.com/us/en/products/interface-connectivity/wireless-communications/cellular-iot-modules/ryz014a-lte-cat-m1-cellular-iot-module?
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Website and Support 

Visit the following vanity URLs to learn about key elements of the RX family, download components and 
related documentation, and get support.  

CK-RX65N Kit Information 

RX&RA Cloud Solutions 

RX Cloud solution web 

RX Product Information  

renesas.com/rx/ck-rx65n 

renesas.com/cloudsolutions  

renesas.com/rx-cloud 

renesas.com/rx  

RX Product Support Forum  renesas.com/rx/forum  

RX Driver Package renesas.com/RDP 

Renesas Support  renesas.com/support 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 

Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and 

application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or 

system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, 

software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other 

intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including 

but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, 

sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all 

liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each 

Renesas Electronics product depends on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic 

appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial 

terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics 

document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury 

(artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power 

control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses 

incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s 

manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or 

software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to any 

unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT 

WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS PRODUCTS 

WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER 

SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR 

RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS 

DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING 

SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR 

PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and 

Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with 

respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all 

liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or 

a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to 

radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, 

and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but 

not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the 

evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems 

manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics 

product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, 

including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas 

Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 

under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and 

administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the 

product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics 

products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 

(Rev.5.0-1  October 2020) 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 

Koto-ku, Tokyo 135-0061, Japan 

www.renesas.com 

 For further information on a product, technology, the most up-to-date 

version of a document, or your nearest sales office, please visit: 

www.renesas.com/contact/. 
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